
CALIBRATION PROCEDURE

NI 5122/5124/5142
This document contains instructions for writing an external calibration 
procedure for National Instruments PXI/PCI-5122/5124/5142 and 
NI PXIe-5122 digitizers. This calibration procedure is intended 
for metrology labs. For more information about calibration, visit 
ni.com/calibration.
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Conventions
The following conventions are used in this manual: 

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

♦ The ♦ symbol indicates that the following text applies only to a specific 
product, a specific operating system, or a specific software version.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on a 
product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document for information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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Software Requirements
Calibrating the NI 5122/5124/5142 requires installing the following 
versions of NI-SCOPE.

You can download NI-SCOPE from the Instrument Driver Network at 
ni.com/idnet. NI-SCOPE supports programming the Self-Calibration 
and Verification sections in a number of programming languages; however, 
only LabVIEW and C are supported for the Adjustment section. 

NI-SCOPE includes all the functions and attributes necessary for 
calibrating the NI 5122/5124/5142. LabVIEW support is installed in 
niScopeCal.llb, and all calibration functions appear in the function 
palette. For LabWindows™/CVI™, the NI-SCOPE function panel 
niScopeCal.fp provides further help on the functions available in CVI. 
Refer to Table 2 for installed file locations.

Calibration functions are LabVIEW VIs or C function calls in the 
NI-SCOPE driver. The C function calls are valid for any compiler capable 
of calling a 32-bit DLL Many of the functions use constants defined in the 
niScopeCal.h file. To use these constants in C, you must include 
niScopeCal.h in your code when you write the calibration procedure.

For more information on the calibration VIs and functions, refer to the 
NI-SCOPE Function Reference Help or the NI-SCOPE LabVIEW 
Reference Help. These references can be found in the NI High-Speed 
Digitizers Help. Refer to the NI-SCOPE Readme for the installed locations 
of these documents.

Table 1.  Required Software for NI 5122/5124/5142 Calibration

Device NI-SCOPE Version

NI PXI-5122 2.5 or later

NI PCI-5122 2.6 or later

NI PXIe-5122 3.3.1 or later

NI PXI/PCI-5124 2.7 or later

NI PXI/PCI-5142 3.0 or later
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Documentation Requirements
You may find the following documentation helpful as you write your 
calibration procedure:

• NI High-Speed Digitizers Getting Started Guide

• NI High-Speed Digitizers Help

• NI PXI/PXIe/PCI-5122 Specifications, NI PXI/PCI-5142 
Specifications, or NI PXI/PCI-5124 Specifications

• NI-SCOPE LabVIEW Reference Help or NI-SCOPE Function 
Reference Help

These documents are installed with NI-SCOPE. You can also download the 
latest versions from the NI Web site at ni.com/manuals.

Table 2.  Calibration File Locations after Installing NI-SCOPE

File Name and Location Description

IVI\Bin\niscope_32.dll NI-SCOPE driver containing the entire 
NI-SCOPE API, including calibration functions

IVI\Lib\msc\niscope.lib NI-SCOPE library for Microsoft C containing 
the entire NI-SCOPE API, including calibration 
functions

LabVIEW (version)\examples\instr\
niScope

Directory of LabVIEW NI-SCOPE example 
VIs, including self-calibration

LabVIEW (version)\instr.lib\niScope
Calibrate\niScopeCal.llb

LabVIEW VI library containing VIs for calling 
the NI-SCOPE calibration API.

IVI\Drivers\niScope\niScopeCal.fp CVI function panel file that includes external 
calibration function prototypes and help on 
using NI-SCOPE in the CVI environment

IVI\Include\niScopeCal.h Calibration header file, which you must include 
in any C program accessing calibration 
functions. This file automatically includes 
niScope.h, which defines the rest of the 
NI-SCOPE interface

IVI\Drivers\niScope\Examples\ Directory of NI-SCOPE examples for CVI, C, 
Visual C++, and Visual Basic
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Password
A password is required to open an external calibration session. If the 
password has not been changed since manufacturing, the password is “NI”.

Calibration Interval

External Calibration
The measurement accuracy requirements of your application determine 
how often you should externally calibrate the NI 5122/5124/5142. 
NI recommends that you perform a complete external calibration at least 
once every two years. You can shorten this interval based on the accuracy 
demands of your application. Refer to Appendix A: Calibration Options for 
more information.

Self-Calibration
Self-calibration can be performed as necessary to compensate for 
environmental changes.

Caution Although you can use self-calibration repeatedly, self-calibrating the 
NI 5122/5124/5142 more than a few times a day may cause excessive wear on the 
relays over time.
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Test Equipment
Table 3 lists the equipment required for externally calibrating the 
NI 5122/5124/5142. If you do not have the recommended instruments, 
use these specifications to select a substitute calibration standard.

Note The delay times indicated in this procedure apply specifically to the Fluke 9500B 
calibrator. If you use a different calibrator, you may need to adjust these delay times.

Test Conditions
Follow these guidelines to optimize the connections and the environment 
during calibration:

• Always connect the calibrator test head directly to the input BNC of 
the digitizer, or use a short 50 Ω BNC coaxial cable if necessary. Long 
cables and wires act as antennae, picking up extra noise that can affect 
measurements.

• Keep relative humidity between 10 and 90% non-condensing, or 
consult the digitizer hardware documentation for the optimum relative 
humidity.

• Maintain an ambient temperature of 23 ±5 °C.

• Allow a warm-up time of at least 15 minutes after the NI-SCOPE 
driver is loaded. Unless manually disabled, the NI-SCOPE driver 
automatically loads with the operating system and enables the device. 
The warm-up time ensures that the measurement circuitry of the 
NI 5122/5124/5142 is at a stable operating temperature. 

Table 3.  Required Equipment Specifications for NI 5122/5124/5142 External Calibration

Required 
Equipment

Recommended 
Equipment

Parameter 
Measured Specification

Signal Generator Fluke 9500B 
oscilloscope 
calibrator

or

Wavetek 9500 with 
high-stability 
reference option

Fluke 9510 Test 
Head

DC Accuracy DC ±(0.025% + 25 μV) into 1 MΩ 
or 50 Ω

Bandwidth, 
Trigger 
Sensitivity

±2% output amplitude flatness for 
leveled sine wave up to 150 MHz 
relative to 50 kHz into 1 MΩ or 
50 Ω

Timing ±2 ppm frequency accuracy

BNC cable — — 50 Ω
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♦ For PXI/PXIe digitizers:

• Ensure that the PXI/PXIe chassis fan speed is set to HI, that the fan 
filters are clean, and that the empty slots contain filler panels.

• Plug the PXI/PXIe chassis and the calibrator into the same power strip 
to avoid ground loops.

♦ For PCI digitizers:

• Plug the PC and the calibrator into the same power strip to avoid 
ground loops.

Calibration Procedures
The calibration process includes the following steps:

1. Initial Setup—Install the device and configure it in Measurement & 
Automation Explorer (MAX).

2. Self-Calibration—Adjust the self-calibration constants of the device.

3. Verification—Verify the existing operation of the device. This step 
confirms whether the device is operating within its specified range 
prior to calibration.

4. Adjustment—Perform an external adjustment of the device that adjusts 
the calibration constants with respect to a known voltage source. The 
adjustment procedure automatically stores the calibration date on the 
EEPROM to allow traceability.

5. Reverification—Repeat the verification procedure to ensure that the 
device is operating within its specifications after adjustment.

These steps are described in more detail in the following sections.

Note  In some cases, the complete calibration procedure may not be required. Refer to 
Appendix A: Calibration Options for more information. 
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Initial Setup
Refer to the NI High-Speed Digitizers Getting Started Guide for 
information about how to install the software and hardware, and 
how to configure the device in MAX.

Self-Calibration
The NI 5122/5124/5142 includes precise internal circuits and references 
used during self-calibration to adjust for time and temperature drift. 

Note Self-calibrate the digitizer before you perform verification. NI-SCOPE includes 
self-calibration example programs for LabVIEW, CVI, and Microsoft Visual C. 

You can initiate self-calibration using the following methods:

• MAX

• Scope Soft Front Panel (SFP)

• NI-SCOPE

MAX
To initiate self-calibration from MAX, complete the following steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Launch MAX.

3. Select My System»Devices and Interfaces»NI-DAQmx Devices.

4. Select the device that you want to calibrate.

5. Initiate self-calibration using one of the following methods:

• Click Self-Calibrate in the upper right corner of MAX.

• Right-click the name of the device in the MAX configuration tree 
and select Self-Calibrate from the drop-down menu.

Scope SFP
To initiate self-calibration from the Scope SFP, complete the following 
steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Launch the Scope SFP, which is available at Start»All Programs»
National Instruments»NI-SCOPE»Scope Soft Front Panel.

3. Select the device you want to calibrate using the Device Configuration 
dialog box by selecting Edit»Device Configuration.
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4. Launch the Calibration dialog box by selecting Utility»Self 
Calibration.

5. Click OK to begin self-calibration.

NI-SCOPE
To self-calibrate the NI 5122/5124/5142 programmatically using 
NI-SCOPE, complete the following steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Open a session and obtain a session handle using the niScope 
Initialize VI.

Note Throughout the procedure, refer to the C/C++ function call parameters for the 
LabVIEW input values.

3. Use the niScope Cal Self Calibrate VI to self-calibrate the digitizer.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

vi: The returned session handle that you 
use to identify the instrument in all 
subsequent NI-SCOPE driver function 
calls
resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_CalSelf
Calibrate with the following 
parameters:

sessionHandle: The instrument 
handle from niScope_init
channelList: VI_NULL
option: VI_NULL
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Note Because the session is a standard session rather than an external calibration session, 
the new calibration constants are immediately stored in the EEPROM. Therefore, you can 
include this procedure in any application that uses the digitizer. 

4. End the session using the niScope Close VI.

Verification

Note After the 15-minute warm-up time, always self-calibrate the digitizer before 
beginning a verification procedure.

This section describes the program you must write to verify either the 
calibration test limits or the published specifications for the digitizer. Refer 
to Appendix A: Calibration Options to determine which limits to use in 
these procedures.

Note If any of these tests fail immediately after you perform an external adjustment, make 
sure that you have met the requirements listed in the Test Equipment and Test Conditions 
sections before you return the digitizer to National Instruments for repair.

Vertical Offset and Vertical Gain Accuracy
Table 4 contains the input parameters for verifying both vertical offset 
accuracy and vertical gain accuracy of the digitizer. 

To verify vertical offset accuracy, complete the procedures described in the 
Vertical Offset Accuracy section for each of the 39 iterations in Table 4 for 
channel 0, then repeat the procedures for channel 1. The Calibration Test 
Limits and Published Specifications for vertical offset accuracy are shown 
in Table 5 (NI 5122/5142) and Table 6 (NI 5124).

To verify vertical gain accuracy, complete the procedures described in the 
Vertical Gain Accuracy section for each of the 39 iterations in Table 4 for 
channel 0, then repeat the procedures for channel 1. The Calibration Test 
Limits and Published Specifications for vertical gain accuracy are shown in 
Table 7 (NI 5122/5142) and Table 8 (NI 5124).

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init
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Table 4.   NI 5122/5124/5142 Input Parameters for Vertical Offset Accuracy 
and Vertical Gain Accuracy Verification

Iteration
Input 

Impedance

Max Input Frequency (Hz)

RangeNI 5122/5142 NI 5124

1 50 Ω 100,000,000 150,000,000 0.2

2 50 Ω 100,000,000 150,000,000 0.4

3 50 Ω 100,000,000 150,000,000 1

4 50 Ω 100,000,000 150,000,000 2

5 50 Ω 100,000,000 150,000,000 4

6 50 Ω 100,000,000 150,000,000 10

7 50 Ω 35,000,000 60,000,000 0.2

8 50 Ω 35,000,000 60,000,000 0.4

9 50 Ω 35,000,000 60,000,000 1

10 50 Ω 35,000,000 60,000,000 2

11 50 Ω 35,000,000 60,000,000 4

12 50 Ω 35,000,000 60,000,000 10

13 50 Ω 20,000,000 20,000,000 0.2

14 50 Ω 20,000,000 20,000,000 0.4

15 50 Ω 20,000,000 20,000,000 1

16 50 Ω 20,000,000 20,000,000 2

17 50 Ω 20,000,000 20,000,000 4

18 50 Ω 20,000,000 20,000,000 10

19 1 MΩ 100,000,000 150,000,000 0.2

20 1 MΩ 100,000,000 150,000,000 0.4

21 1 MΩ 100,000,000 150,000,000 1

22 1 MΩ 100,000,000 150,000,000 2

23 1 MΩ 100,000,000 150,000,000 4

24 1 MΩ 100,000,000 150,000,000 10

25 1 MΩ 100,000,000 150,000,000 20
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26 1 MΩ 35,000,000 60,000,000 0.2

27 1 MΩ 35,000,000 60,000,000 0.4

28 1 MΩ 35,000,000 60,000,000 1

29 1 MΩ 35,000,000 60,000,000 2

30 1 MΩ 35,000,000 60,000,000 4

31 1 MΩ 35,000,000 60,000,000 10

32 1 MΩ 35,000,000 60,000,000 20

33 1 MΩ 20,000,000 20,000,000 0.2

34 1 MΩ 20,000,000 20,000,000 0.4

35 1 MΩ 20,000,000 20,000,000 1

36 1 MΩ 20,000,000 20,000,000 2

37 1 MΩ 20,000,000 20,000,000 4

38 1 MΩ 20,000,000 20,000,000 10

39 1 MΩ 20,000,000 20,000,000 20

Table 4.   NI 5122/5124/5142 Input Parameters for Vertical Offset Accuracy 
and Vertical Gain Accuracy Verification (Continued)

Iteration
Input 

Impedance

Max Input Frequency (Hz)

RangeNI 5122/5142 NI 5124
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Vertical Offset Accuracy
Complete the following steps to verify vertical offset accuracy of the 
NI 5122/5124/5142. You must verify both channels with each iteration in 
Table 4. 

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

Note Throughout the procedure, refer to the C/C++ function call parameters for the 
LabVIEW input values.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI. 

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

vi: The instrument handle from 
niScope_init

channelList: "0"
inputImpedance: The Input 
Impedance value in Table 4 for the 
current iteration 
maxInputFrequency: The 
Maximum Input Frequency value 
in Table 4 for the current iteration
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI. 

LabVIEW VI C/C++ Function Call

Call 
niScope_ConfigureVertical 
with the following parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: The Range value in Table 4 
for the current iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 100,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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6. Short-circuit the channel 0 input of the digitizer by connecting the 
calibrator test head directly to the digitizer and grounding the output 
of the calibrator. 

7. Wait 500 ms for the calibrator to ground its output.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI.

Compare the resulting average voltage to the value listed in the 
Calibration Test Limits column or the Published Specifications 
column in Table 5 (NI 5122/5142) or Table 6 (NI 5124) that 
corresponds to the vertical range used. 

Note The inputImpedance and maxInputFrequency do not affect the test limit value. 

If the result is within the selected test limit, the device has passed this 
portion of the verification.

10. Repeat steps 2 through 9 for each iteration in Table 4.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE

_AVERAGE
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11. Move the calibrator test head to the digitizer input channel 1 and repeat 
steps 2 through 10 for every configuration in Table 4, changing the 
value of the channelList parameter from "0" to "1".

12. End the session using the niScope Close VI.

You have finished verifying the vertical offset accuracy of the 
NI 5122/5124/5142.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init

Table 5.  NI 5122/5142 Vertical Offset Limits

Range

NI PXI/PXIe-5122 and NI PXI-5142 NI PCI-5122/5142

Calibration Test 
Limits (V)

Published 
Specifications (V)

Calibration Test 
Limits (V)

Published 
Specifications (V)

0.2 ±0.00058 ±0.001 ±0.00114 ±0.002

0.4 ±0.00056 ±0.001 ±0.00114 ±0.002

1 ±0.00076 ±0.0012 ±0.00114 ±0.002

2 ±0.0008 ±0.0016 ±0.00114 ±0.002

4 ±0.0033 ±0.008 ±0.0033 ±0.008

10 ±0.0036 ±0.008 ±0.0036 ±0.008

20 ±0.005 ±0.013 ±0.005 ±0.013

Table 6.  NI 5124 Vertical Offset Limits

Range

NI PXI-5124 NI PCI-5124

Calibration Test 
Limits (V)

Published 
Specifications (V)

Calibration Test 
Limits (V)

Published 
Specifications (V)

0.2 ±0.0008 ±0.0013 ±0.0013 ±0.0018

0.4 ±0.0008 ±0.0013 ±0.0013 ±0.0018

1 ±0.0011 ±0.0015 ±0.0016 ±0.0021

2 ±0.0011 ±0.0015 ±0.0016 ±0.0021

4 ±0.00575 ±0.01 ±0.005 ±0.010
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Vertical Gain Accuracy
Complete the following steps to verify the vertical gain accuracy of the 
digitizer. You must verify both channels with each iteration in Table 4.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

10 ±0.00575 ±0.01 ±0.005 ±0.01 

20 ±0.00575 ±0.01 ±0.005 ±0.01 

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

channelList: "0"
inputImpedance: The Input 
Impedance value in Table 4 for 
the current iteration
maxInputFrequency: The 
Maximum Input Frequency value 
in Table 4 for the current iteration

Table 6.  NI 5124 Vertical Offset Limits (Continued)

Range

NI PXI-5124 NI PCI-5124

Calibration Test 
Limits (V)

Published 
Specifications (V)

Calibration Test 
Limits (V)

Published 
Specifications (V)
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: The Range value in Table 4 
for the current iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 100,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init



© National Instruments Corporation 19 NI 5122/5124/5142 Calibration Procedure

6. Connect the calibrator test head directly to the channel 0 input 
of the digitizer and output the Positive Input voltage from Table 7 
(NI 5122/5142) or Table 8 (NI 5124) that corresponds to the vertical 
range used. Be sure to configure the load impedance of the calibrator 
to match the input impedance of the digitizer.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Positive Voltage used in step 14.

10. Using the calibrator, output the Negative Input voltage listed in Table 7 
(NI 5122/5142) or Table 8 (NI 5124) that corresponds to the vertical 
range used.

11. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: NISCOPE_
VAL_VOLTAGE_AVERAGE
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12. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

13. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Negative Voltage used in step 14.

14. Calculate the error in the vertical gain as a percentage of input using 
the following formula:

where

a = the Measured Positive Voltage

b = the Measured Negative Voltage

c = the applied Positive Voltage

d = the applied Negative Voltage

Compare the resulting percent error to the Calibration Test Limits 
or the Published Specifications listed in Table 7 (NI 5122/5142) or 
Table 8 (NI 5124). If the result is within the selected test limit, the 
device has passed this portion of the verification.

15. Repeat steps 2 through 14 for each iteration in Table 4.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call 
niScope_FetchMeasurement 
with the following parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: NISCOPE_
VAL_VOLTAGE_AVERAGE

error a b–
c d–
------------⎝ ⎠

⎛ ⎞ 1–⎝ ⎠
⎛ ⎞ 100×=
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16. Move the calibrator test head to the digitizer input channel 1 and repeat 
steps 2 through 15 for every configuration in Table 4, changing the 
value of the channelList parameter from "0" to "1".

17. End the session using the niScope Close VI.

Table 7.  NI 5122/5142 Vertical Gain Stimuli and Limits

Range 
(V)

Positive
Input (V)

Negative
Input (V)

Calibration 
Test Limits

Published 
Specifications

0.2 0.09 –0.09 ±0.37% ±0.65%

0.4 0.18 –0.18 ±0.37% ±0.65%

1 0.45 –0.45 ±0.37% ±0.65%

2 0.9 –0.9 ±0.37% ±0.65%

4 1.8 –1.8 ±0.37% ±0.65%

10 4.5 –4.5 ±0.37% ±0.65%

20 9 –9 ±0.37% ±0.65%

Table 8.  NI 5124 Vertical Gain Stimuli, Calibration Test Limits, 
and Published Specifications

Range 
(V)

Positive
Input (V)

Negative
Input (V)

Calibration 
Test Limits

Published 
Specifications

0.2 0.09 –0.09 ±0.3975% ±0.65%

0.4 0.18 –0.18 ±0.3975% ±0.65%

1 0.45 –0.45 ±0.3975% ±0.65%

2 0.9 –0.9 ±0.3975% ±0.65%

4 1.8 –1.8 ±0.3975% ±0.65%

10 4.5 –4.5 ±0.3975% ±0.65%

20 9 –9 ±0.3975% ±0.65%

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init



NI 5122/5124/5142 Calibration Procedure 22 ni.com

You have finished verifying the vertical gain accuracy of the 
NI 5122/5124/5142.

Programmable Vertical Offset Accuracy
Complete the following steps to verify the programmable vertical offset 
accuracy for each digitizer channel.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

vi: The instrument handle from
niScope_init

channelList: "0"
inputImpedance: 
NISCOPE_VAL_1_MEG_OHM

maxInputFrequency: 
100,000,000 (for 
NI 5122/5142), 
150,000,000 (for NI 5124)
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: 2.0
offset: 0.75
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 100,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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6. Connect the calibrator test head directly to the channel 0 input of the 
digitizer and output 0.75 V with a 1 MΩ load impedance.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Positive Voltage used in step 16.

10. Output –0.75 V with the calibrator.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call 
niScope_FetchMeasurement 
with the following parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_AVERAGE
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11. Configure the common vertical properties using the niScope Configure 
Vertical VI.

12. Commit all the parameter settings to hardware using the niScope 
Commit VI.

13. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

14. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

LabVIEW VI C/C++ Function Call

Call 
niScope_ConfigureVertical 
with the following parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: 2.0
offset: –0.75
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init
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15. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Negative Voltage used in step 16.

16. Calculate the error in the programmable vertical offset as a percentage 
of input using the following formula:

error = (((a – b) / 1.5) – 1) * 100

where

a = the Measured Positive Voltage

b = the Measured Negative Voltage

Compare the resulting percent to the Calibration Test Limits or the 
Published Specifications listed in Table 9. If the result is within the 
selected test limit, the device has passed this portion of the verification.

17. Move the calibrator test head to the digitizer input channel 1 and repeat 
steps 2 through 16, changing the value of the channelList parameter 
from "0" to "1".

18. End the session using the niScope Close VI.

LabVIEW VI C/C++ Function Call

Call niScope_FetchMeasurement 
with the following parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_AVERAGE

Table 9.  NI 5122/5124/5142 Programmable Vertical Offset Accuracy Limits

Calibration Test Limits Published Specifications

±0.36% ±0.4%

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init
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You have finished verifying the programmable vertical offset accuracy of 
the NI 5122/5124/5142.

Timing Accuracy
Complete the following steps to verify the timing accuracy for the 
NI 5122/5124/5142.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

channelList: "0"
inputImpedance: 
NISCOPE_VAL_50_OHM

maxInputFrequency: 
20,000,000
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: 2.0
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 100,000,000
refPosition: 50.0
minNumPts: 1,000,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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6. Connect the scope calibrator test head directly to the channel 0 input 
of the digitizer. Configure the calibrator to output an exact 11 MHz 
sine wave with 1 Vpk-pk amplitude and 50 Ω load impedance.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Retrieve a waveform using the niScope Fetch (poly) VI. Select the 
WDT instance of the VI. Use the default value for the timestamp Type 
parameter.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch with the 
following parameters:

timeout: 5.0
vi: The instrument handle from 
niScope_init

channelList: "0"
numSamples: -1
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10. Measure the exact frequency of the peak around 11 MHz using the 
Extract Single Tone Information VI with the following inputs.

• advanced search»approx freq.: –1

• advanced search»search: 5

• export signals: 0 (none)

11. Calculate the error in timing as parts per million (ppm) using the 
following formula:

error = (a – 11,000,000) / 11

where a is the measured frequency.

Compare the result to the Calibration Test Limits or the Published 
Specifications listed in Table 10. If the result is within the selected test 
limit, the device has passed this portion of the verification.

Note The same time source is used for both channel 0 and channel 1, so you only need to 
verify the timing accuracy on one channel.

12. End the session using the niScope Close VI.

You have finished verifying the timing accuracy of the NI 5122/5124/5142.

LabVIEW VI C/C++ Function Call

Perform an FFT on the array of 
data from step 9.

Table 10.  NI 5122/5124/5142 Timing Accuracy Limits

Calibration Test Limits Published Specifications

±5.3 ppm  ±25 ppm

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init
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Bandwidth and Flatness
Complete the following steps to verify the bandwidth and flatness of the 
NI 5122/5124/5142. You must verify both channels with each iteration 
listed in Table 11 (NI 5122/5142) or Table 12 (NI 5124).

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

vi: The instrument handle from
niScope_init 

channelList: "0"
inputImpedance: The Input 
Impedance value in Table 11 
(NI 5122/5142) or Table 12 
(NI 5124) for the current iteration
maxInputFrequency: The 
Maximum Input Frequency value in 
Table 11 (NI 5122/5142) or 
Table 12 (NI 5124) for the current 
iteration
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: The Range value in 
Table 11 (NI 5122/5142) or 
Table 12 (NI 5124) for the current 
iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 30,000
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5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

6. Connect the calibrator test head directly to the channel 0 input of the 
digitizer. Configure the calibrator to output a 50 kHz sine wave with 
peak-to-peak voltage amplitude set to half the vertical range of the 
digitizer. Configure the load impedance of the calibrator to match the 
input impedance of the digitizer.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage RMS 
measurement using the niScope Fetch Measurement (poly) VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured RMS Voltage of 50 kHz Sine Wave used in step 11. e.

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_RMS
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10. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

11. Repeat steps 11. a through 11. e for each Input Frequency listed for the 
current iteration in Table 11 (NI 5122/5142) or Table 12 (NI 5124).

a. Configure the calibrator to output the Input Frequency for the 
current iteration in Table 11 (NI 5122/5142) or Table 12 
(NI 5124).

b. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

c. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 100,000,000 
(for NI 5122/5142), 
200,000,000 (for NI 5124)
refPosition: 50.0
minNumPts: 300,000

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init
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d. Fetch a waveform from the digitizer and perform a voltage RMS 
measurement using the niScope Fetch Measurement (poly) VI. 
Select the Measurement Scalar DBL instance of the VI. This value 
is the Measured RMS Voltage of Generated Sine Wave used in 
step 11. e.

e. Calculate the power difference using the following formula:

power = (20log10 a) – (20log10 b)

where 

a = the Measured RMS Voltage of Generated Sine Wave

b = the Measured RMS Voltage of 50 kHz Sine Wave

If the result is within the test limits from Table 11 (NI 5122/5142) 
or Table 12 (NI 5124), the device has passed this portion of the 
verification.

12. Repeat steps 2 through 11 for each iteration in Table 11 
(NI 5122/5142) or Table 12 (NI 5124).

13. Move the calibrator test head to the digitizer input channel 1 and repeat 
steps 2 through 12, changing the value of the channelList parameter 
from "0" to "1".

14. End the session using the niScope Close VI.

You have finished verifying the bandwidth and flatness of the 
NI 5122/5124/5142.

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_RMS

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init
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Table 11.   NI 5122/5142 Bandwidth and Flatness Stimuli and Published Specifications

Iteration
Max Input 
Frequency

Input 
Impedance

Range 
(V)

Input 
Frequency (Hz)

NI 5122/5142 Published
Specifications

Max Level 
(dB)

Min Level 
(dB)

1 100 MHz 50 Ω 0.2 20,000,000 0.4 –0.4

40,000,000 1 –1

80,000,000 3 –3

2 100 MHz 50 Ω 0.4 20,000,000 0.4 –0.4

50,000,000 1 –1

100,000,000 3 –3

3 100 MHz 1 MΩ 0.2 20,000,000 0.4 –0.4

40,000,000 1 –1

80,000,000 3 –3

4 100 MHz 1 MΩ 0.4 20,000,000 0.4 –0.4

50,000,000 1 –1

100,000,000 3 –3

5 35 MHz 50 Ω 0.4 16,000,000 1.2 –1.2

32,000,000 1.6 –1.6

35,000,000 3 –3

6 20 MHz 50 Ω 0.4 15,100,000 N/A –3*

25,100,000 –3* N/A

* Published specifications value listed for validation of noise filter only. The specification is not included in device 
specifications documents.
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Table 12.  NI 5124 Bandwidth and Flatness Stimuli and Published Specifications

Iteration
Max Input 
Frequency

Input 
Impedance

Range 
(V)

Input 
Frequency (Hz)

NI 5124 Published
Specifications

Max Level 
(dB)

Min Level 
(dB)

1 150 MHz 50 Ω 0.2 20,000,000 0.6 –0.6

40,000,000 1.5 –1.5

85,000,000 3 –3

2 150 MHz 50 Ω 0.4 20,000,000 0.5 –0.5

50,000,000 1 –1

100,000,000 1.7 –1.7

150,000,000 3 –3

3 150 MHz 1 MΩ 0.2 20,000,000 0.6 –0.6

40,000,000 1.5 –1.5

75,000,000 3 –3

4 150 MHz 1 MΩ 0.4 20,000,000 0.5 –0.5

50,000,000 1 –1

100,000,000 1.7 –1.7

145,000,000 3 –3

5 60 MHz 50 Ω 4 22,100,000 2.0 –1.0

55,000,000 2.0 –1.0

6 20 MHz 50 Ω 0.4 15,100,000 N/A –3*

25,100,000 –3* N/A

* Published specifications value listed for validation of noise filter only. The specification is not included in device 
specifications documents.
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Trigger Sensitivity
Complete the following steps to verify the trigger sensitivity of the 
NI 5122/5124/5142. You must verify channel 0, channel 1, and the external 
trigger channel using the corresponding iterations in Table 13. 

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

vi: The instrument handle from
niScope_init 

channelList: "0"
inputImpedance: 
NISCOPE_VAL_50_OHM

maxInputFrequency: 
100,000,000
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: 0.2
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 50
vi: The instrument handle from 
niScope_init

minSampleRate: 100,000,000
refPosition: 50.0
minNumPts: 1,000
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5. Configure an edge trigger using the niScope Configure Trigger (poly) 
VI. Select the Analog Edge Ref Trigger instance of the VI.

Note The trigger level is set to center the trigger hysteresis window at 0.0 V.

6. Commit all the parameter settings to hardware using the niScope 
Commit VI.

7. Connect the scope calibrator test head directly to the digitizer input for 
the channel you are testing. Configure the calibrator to output the 
appropriate signal in Table 13.

8. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
TriggerEdge with the following 
parameters:

triggerCoupling: NISCOPE_VAL_DC
slope: The Slope value in Table 13 for 
the current iteration 
vi: The instrument handle from 
niScope_init

triggerSource: The Trigger Source 
value in Table 13 for the current 
iteration
level: The Level value in Table 13 for 
the current iteration
holdoff: 0
delay: 0

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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9. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

10. Acquire a waveform using the niScope Fetch (poly) VI. Select the 
Cluster instance of the VI.

11. If the digitizer does not time out, the digitizer has passed this portion 
of the verification. If the digitizer does time out, you must call the 
niScope Abort VI to end the acquisition.

12. To verify the trigger sensitivity on channel 1, repeat steps 2 through 11 
using the values in Table 13, iterations 5 through 8. Make the following 
changes:

• Change channelList to "1" in steps 2, 3, and 10

• Connect the calibrator test head to channel 1 in step 7

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch with the 
following parameters:

timeout: 2.0
vi: The instrument handle from 
niScope_init

channelList: "0"
numSamples: –1

LabVIEW VI C/C++ Function Call

Call niScope_Abort with the 
following parameter:

vi: The instrument handle from 
niScope_init
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13. To verify the trigger sensitivity on the external trigger channel, repeat 
steps 2 through 11 using the values in Table 13, iterations 9 through 
12. Make the following changes:

• Change the channelList to “0”

• Connect the calibrator test head to the external trigger channel 
(TRIG) in step 7.

14. End the session using the niScope Close VI.

You have finished verifying the trigger sensitivity for the 
NI 5122/5124/5142.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init

Table 13.  NI 5122/5124/5142 Trigger Sensitivity Inputs

Iteration
Trigger 
Source Level Slope

Calibrator Signal

NI 5122/5142 NI 5124 

1 0 1.25 mV NISCOPE_VAL_
POSITIVE

4.84 mVpk-pk 
50 MHz sine 
wave with 50 Ω 
load impedance

6.84 mVpk-pk 
50 MHz sine wave 
with 50 Ω load 
impedance

2 0 –1.25 mV NISCOPE_VAL_
NEGATIVE

3 0 1.25 mV NISCOPE_VAL_
POSITIVE

9.70 mVpk-pk 
100 MHz sine 
wave with 50 Ω 
load impedance

19.0 mVpk-pk 
150 MHz sine 
wave with 50 Ω 
load impedance

4 0 –1.25 mV NISCOPE_VAL_
NEGATIVE

5 1 1.25 mV NISCOPE_VAL_
POSITIVE

4.84 mVpk-pk 
50 MHz sine 
wave with 50 Ω 
load impedance

6.84 mVpk-pk 
50 MHz sine wave 
with 50 Ω load 
impedance

6 1 –1.25 mV NISCOPE_VAL_
NEGATIVE

7 1 1.25 mV NISCOPE_VAL_
POSITIVE

9.7 mVpk-pk 
100 MHz sine 
wave with 50 Ω 
load impedance

19.0 mVpk-pk 
150 MHz sine 
wave with 50 Ω 
load impedance

8 1 –1.25 mV NISCOPE_VAL_
NEGATIVE
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Adjustment
If the NI 5122/5124/5142 successfully passed each of the verification 
procedures within the calibration test limits, then an adjustment is 
recommended but not required to guarantee its published specifications for 
the next two years. If the digitizer was not within the calibration test limits 
for each of the verification procedures, you can perform the adjustment 
procedure to improve the accuracy of the digitizer. Refer to Appendix A: 
Calibration Options to determine which procedures to perform.

An adjustment is required only once every two years. Following the 
adjustment procedure automatically updates the calibration date and 
temperature in the EEPROM of the digitizer. 

Note If the digitizer passed the entire verification procedure within the calibration test 
limits and you do not want to perform an adjustment, you can update the calibration date 
and onboard calibration temperature without making any adjustments by completing only 
steps 2 and 11 in this section. 

9 VAL_
EXTERNAL

62.5 mV NISCOPE_VAL_
POSITIVE

240 mVpk-pk 
100 MHz sine 
wave with 1 MΩ 
load impedance

240 mVpk-pk 
100 MHz sine 
wave with 1 MΩ 
load impedance

10 VAL_
EXTERNAL

–62.5 mV NISCOPE_VAL_
NEGATIVE

11 VAL_
EXTERNAL

62.5 mV NISCOPE_VAL_
POSITIVE

940 mVpk-pk 
200 MHz sine 
wave with 1 MΩ 
load impedance

940 mVpk-pk 
200 MHz sine 
wave with 1 MΩ 
load impedance

12 VAL_
EXTERNAL

–62.5 mV NISCOPE_VAL_
NEGATIVE

Table 13.  NI 5122/5124/5142 Trigger Sensitivity Inputs (Continued)

Iteration
Trigger 
Source Level Slope

Calibrator Signal

NI 5122/5142 NI 5124 
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Complete all of the following steps to externally adjust the 
NI 5122/5124/5142.

1. Connect the scope calibrator test head directly to the channel 1 input 
of the digitizer. Configure the calibrator to output an exact 4 V DC 
signal into a 1 MΩ load impedance.

2. Obtain an instrument session handle using the niScope Cal Start VI.

3. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

4. Adjust the vertical range using the niScope Cal Adjust Range VI.

5. Wait 500 ms for the calibrator to ground its output to channel 1 of the 
digitizer.

LabVIEW VI C/C++ Function Call

Call niScope_CalStart with the 
following parameters:

resourceName: The name of the 
device to calibrate. You can find this 
name under Devices and Interfaces in 
MAX.
password: The password required to 
open an external calibration session. 
If this password has not been changed 
since manufacturing, the password is 
"NI".

LabVIEW VI C/C++ Function Call

Call niScope_CalAdjust
Range with the following 
parameters:

sessionHandle: The instrument 
handle from niScope_CalStart
channelName: "1"
range: 0
stimulus: 4.0
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6. Adjust the vertical range using the niScope Cal Adjust Range VI.

7. Using a BNC cable, connect REF FREQUENCY OUTPUT on the 
back of the calibrator to the channel 0 input of the digitizer. Make sure 
the output of the reference frequency is enabled and set to 10 MHz. 
If you are not using a Fluke 9500B/Wavetek 9500 calibrator, connect 
a precise 10 MHz, 1 Vpk-pk sine or square wave source to channel 0.

8. Adjust the sample rate using the niScope Cal Adjust VCXO VI.

Note The 10 MHz stimulus is automatically taken from channel 0.

9. Disconnect or disable all inputs to the digitizer.

LabVIEW VI C/C++ Function Call

Call niScope_CalAdjust
Range with the following 
parameters:

sessionHandle: The session 
handle from niScope_CalStart
channelName: "1"
range: 0 
stimulus: 0.0

LabVIEW VI C/C++ Function Call

Call niScope_CalAdjust
VCXO with the following 
parameters:

sessionHandle: The 
instrument handle from 
niScope_CalStart

stimulusFreq: 10,000,000
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10. Self-calibrate the digitizer using niScope Cal Self Calibrate VI.
 

11. End the session and save the results using the niScope Cal End VI.

You have finished adjusting the NI 5122/5124/5142. It is not necessary to 
adjust each channel individually; however, you should repeat the entire 
verification procedure to verify a successful adjustment.

LabVIEW VI C/C++ Function Call

Call niScope_CalSelf
Calibrate with the following 
parameters:

sessionHandle: The instrument 
handle from 
niScope_CalStart

channelList: VI_NULL
option: VI_NULL

LabVIEW VI C/C++ Function Call

Call niScope_CalEnd with the following 
parameters:

sessionHandle: The instrument handle you 
obtained from niScope_CalStart
action: NISCOPE_VAL_ACTION_STORE
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Appendix A: Calibration Options
External calibration involves verification and if necessary, adjustment and 
reverification. Adjustment is the process of measuring and compensating 
for device performance to improve the measurement accuracy. Performing 
an adjustment updates the calibration date, effectively resetting the 
calibration interval. The device is guaranteed to meet or exceed its 
published specifications for the duration of the calibration interval. 
Verification is the process of testing the device to ensure that the 
measurement accuracy is within certain specifications. Verification
can be used to ensure that the adjustment process was successful or to 
determine if the adjustment process needs to be performed at all. During 
verification, you must compare the measurement error to the limits given 
in each section.

This document provides two sets of test limits for most verification 
stages—the calibration test limits and the published specifications. The 
calibration test limits are more restrictive than the published specifications. 
If all of the measurement errors determined during verification fall within 
the calibration test limits, the device is guaranteed to meet or exceed its 
published specifications for a full calibration interval (two years). For this 
reason, you must verify against the calibration test limits when performing 
verification after adjustment. If all of the measurement errors determined 
during verification fall within the published specifications, but not within 
the calibration test limits, the device is meeting its published specifications. 
However, the device will not necessarily remain within these specifications 
for an additional two years. The device will meet published specifications 
for the remainder of the current calibration interval. In this case, you can 
perform an adjustment if you want to further improve the measurement 
accuracy or reset the calibration interval. If some measurement errors 
determined during verification do not fall within the published 
specifications, you must perform an adjustment to restore the device 
operation to its published specifications.

The Complete Calibration section describes the recommended calibration 
procedure. The Optional Calibration section describes alternative 
procedures that allow you to skip adjustment if the device already meets 
its calibration test limits or published specifications.
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Complete Calibration
Performing a complete calibration is the recommended way to guarantee 
that the NI 5122/5124/5142 will meet or exceed its published specifications 
for a two-year calibration interval. At the end of the complete calibration 
procedure, you verify that the measurement error falls within the 
calibration test limits. Figure 1 shows the programming flow for 
complete calibration.

Figure 1.  Complete Calibration Programming Flow
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Optional Calibration
You can choose to skip the adjustment steps of the calibration procedure if 
the measurement error is within the calibration test limits or the published 
specifications during the first verification. If all of the measurement 
errors determined during the first verification fall within the calibration 
test limits, the device is guaranteed to meet or exceed its published 
specifications for a full calibration interval. In this case, you can update 
the calibration date, effectively resetting the calibration interval, without 
actually performing an adjustment. Refer to the Adjustment section for 
more information. 

If all of the measurement errors determined during the first verification fall 
within the published specifications, but not within the calibration test 
limits, adjustment is also optional. However, you cannot update the 
calibration date, because the device will not necessarily operate within 
the published specifications for an additional two years.

Note Regardless of the results of the first verification, if you choose to perform an 
adjustment, you must verify that the measurement error falls within the calibration test 
limits at the end of the calibration procedure. 
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Figure 2 shows the programming flow for the optional calibration.

Figure 2.  Optional Calibration Programming Flow
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Appendix B: Calibration Utilities
NI-SCOPE supports several calibration utilities that allow you to retrieve 
information about adjustments performed on the NI 5122/5124/5142, 
change the external calibration password, and store small amounts of 
information in the onboard EEPROM. You can retrieve some data using 
MAX, however, you can retrieve all the data programmatically using 
NI-SCOPE functions.

MAX
To retrieve data using MAX, complete the following steps:

1. Select the device from which you want to retrieve information from 
My System»Devices and Interfaces»NI-DAQmx Devices.

2. Select the Calibration tab in the lower right corner.

You should see information about the last date and temperature for both 
external and self-calibration.

NI-SCOPE
NI-SCOPE provides a full complement of calibration utility functions 
and VIs. Refer to the NI High-Speed Digitizers Help for the complete 
function reference and VI reference. The utility functions include:

• niScope Cal Change Password VI (niScope_CalChangePassword)

• (niScope Cal Fetch Count VI (niScope_CalFetchCount)

• niScope Cal Fetch Date VI (niScope_CalFetchDate))

• niScope Cal Fetch Misc Info VI (niScope_CalFetchMiscInfo 

• niScope Cal Fetch Temperature VI 
(niScope_CalFetchTemperature)

• niScope Cal Store Misc Info VI (niScope_CalStoreMiscInfo)



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. 
Refer to the Terms of Use section on ni.com/legal for more information about National 
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade 
names of their respective companies. For patents covering National Instruments products, refer to the 
appropriate location: Help»Patents in your software, the patents.txt file on your CD, or 
ni.com/patents.

© 2004–2007 National Instruments Corporation. All rights reserved. 370529D-01 Jun07

Where to Go for Support
The National Instruments Web site is your complete resource for technical 
support. At ni.com/support you have access to everything from 
troubleshooting and application development self-help resources to email 
and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the 
Council of the European Communities using the manufacturer’s 
declaration of conformity. This system affords the user protection for 
electronic compatibility (EMC) and product safety. You can obtain the DoC 
for your product by visiting ni.com/certification. If your product 
supports calibration, you can obtain the calibration certificate for your 
product at ni.com/calibration.

National Instruments corporate headquarters is located at 
11500 North Mopac Expressway, Austin, Texas, 78759-3504. 
National Instruments also has offices located around the world to help 
address your support needs. For telephone support in the United States, 
create your service request at ni.com/support and follow the calling 
instructions or dial 512 795 8248. For telephone support outside the United 
States, contact your local branch office: 

Australia 1800 300 800, Austria 43 662 457990-0, 
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, 
Canada 800 433 3488, China 86 21 5050 9800, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 385 (0) 9 725 72511, France 01 57 66 24 24, 
Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737, 
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, 
Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, 
Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851, 
Singapore 1800 226 5886, Slovenia 386 3 425 42 00, 
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, 
Taiwan 886 02 2377 2222, Thailand 662 278 6777, 
Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545
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